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Part Names

Front

No. Name Function overview

Maintenance cover
Remove when performing manual cleaning.

P. 75Manual Cleaning

Front cover Keep this cover closed except when necessary, such as when
loading media.

Print-head carriage The print heads and blade are inside this carriage.

[POWER]Key Switches the printer on and off.

Cartridge slots The location where ink cartridges are installed.

Pinch roller These clamp the media when the loading lever is moved to the
front of the machine. The right pinch roller is fixed in place.

Platen
This is the path over which the media passes. A suction fan that
keeps the media from coming loose and a print heater that helps
fix the ink are built in.

Media clamp These keep the media from coming loose and prevent fuzz on the
cut edge of the media from touching the print heads.

Blade protector This protects the tip of the blade during cutting.

Grit roller These rollers feed out media toward the front of the machine.

Introduction
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Rear

No. Name Function overview

Loading lever Operate this when you load media.

USB connector -

Main power switch -

Power-cord connector -

Left media guide Use this guide when loading media. This guide is on the "Left"
when viewing the printer from the front.

Right media guide Use this guide when loading media. This guide is on the "Right"
when viewing the printer from the front.

Waste cartridge -

Introduction
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System Configuration of This Machine

"VersaWorks 6" is written as "VersaWorks" in this manual.

System configuration

The following combination of devices and software can be used to generate output.

• Commercial application software + BN-20 driver

• Commercial application software + VersaWorks + BN-20 driver

When you use VersaWorks, the BN-20 driver's printing preferences become invalid.

MEMO

Commercially available ap-
plication software

Verified application software

• Adobe Illustrator CS6 or later
• CorelDraw X3 or later

VersaWorks
Software RIP (Raster Image Processor).
For more information, see "VersaWorks Installation Guide."

BN-20 driver

Driver software that is needed to output printing data from a computer to the ma-
chine.
It is also used to set the printing preferences in the case that you use commercial ap-
plication software.

Utility

Software that is needed to operate the machine. The major functions are shown below.

• Display of messages and error messages
• Adjustment function
• Management of ink remaining amount
• Maintenance function

 RELATED LINKS 

・  P. 11Displaying the BN-20 Driver's Printing Preferences Dialog Box

・  P. 14How to Open the BN-20 Driver / VersaWorks Help

・  P. 12Starting/Exiting Utility

Introduction
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・ VersaWorks Installation Guide

Introduction
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Procedure

1. Open the [Devices and printers] window.

• Windows 11

From the Start menu, click [All apps]>[Windows Tool]>[Control Panel]>[View devices and
printers].

• Windows 10

From the Start menu, click [Windows System]>[Control Panel]>[View devices and printers].

2. Right-click the [Roland BN-20] icon, and then click Printing Preferences.

The BN-20 driver's Printing Preferences dialog box opens.

Displaying the BN-20 Driver's Printing Preferen-
ces Dialog Box

Basic Information 11



Opening the Utility Window

Click  (the Utility icon) in the notification area. (Or, right-click the  icon, and then click [View/
Hide].)

The Utility window is displayed.

Utility is resident software.

Utility is "resident software" that is always running. To hide the window, click  in the upper-right corner of the
window or click [Close]; Utility will not terminate.

If  is not displayed in the notification area, start Utility from the Windows Start menu.

MEMO

Starting from the Windows [Start] Menu

Windows 11

From the Start menu, click [All apps]>[BN-20 Utility for Windows]>[BN-20 Utility for Windows].

Windows 10

From the Start menu, click [BN-20 Utility for Windows]>[BN-20 Utility for Windows].

Exiting Utility

Right-click  (the Utility icon) in the notification area, and then click [End]. This exits the utility.

Starting/Exiting Utility
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Windows 11

From the Start menu, click [All apps]>[VersaWorks]>[VersaWorks].

Windows 10

From the Start menu, click [VersaWorks]>[VersaWorks].

 RELATED LINKS 

・ https://downloadcenter.rolanddg.com/VersaWorks6

Starting VersaWorks
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BN-20 Driver

Display the BN-20 driver's Printing Preferences dialog box, and then click [Help].

 RELATED LINKS 

・  P. 11Displaying the BN-20 Driver's Printing Preferences Dialog Box

VersaWorks

Start VersaWorks, and then click [Help]>[Show Help] from the menu.

Windows 11

From the Start menu, click [All apps]>[VersaWorks]>[VersaWorks Help].

Windows 10

From the Start menu, click [VersaWorks]>[VersaWorks Help].

 RELATED LINKS 

How to Open the BN-20 Driver / VersaWorks Help
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・  P. 13Starting VersaWorks

How to Open the BN-20 Driver / VersaWorks Help
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Types of Media

This Master Guide uses the word “media” to mean sheets used for output. Media used with this machine
are broadly classified into two types:

• Roll media: Media wound onto a paper tube

• Sheet media: Any media that is not wound on to a paper tube, e.g. standard size paper sheets

For both roll and sheet media, different types of paper can be selected according to the purpose. For de-
tails contact your media supplier. Media can also be purchased from the Roland DG Corp. website.

 RELATED LINKS 

・ https://www.rolanddg.com/

Usable Media

This machine cannot print on every kind of media. Before selecting media, be sure to perform trial print-
ing to check whether satisfactory output quality is obtained.

Size

Usable Media

Width *1 • 150 to 170 mm (5.9 to 6.7 in.)
• 200 to 235 mm (7.9 to 9.3 in.)
• 287 to 322 mm (11.3 to 12.7 in.)
• 348 to 383 mm (13.7 to 15.1 in.)
• 393 to 429 mm (15.5 to 16.9 in.)
• 439 to 474 mm (17.3 to 18.7 in.)
• 487 to 515 mm (19.2 to 20.3 in.)

Cuttable media thickness*1 Max. 0.22 mm (8.66 mil; depending on the media composition)

Maximum media thickness (including back-
ing paper)*1

When only printing: 1.0 mm (39.4 mil)
When performing cutting: 0.4 mm (15 mil)

Maximum roll outer diameter 150 mm (5.9 in.)

Paper tube (core) inner diameter 76.2 mm (3 in.) or 50.8 mm (2 in.)

 

*1 Applies to both roll and sheet media
 

Maximum Roll Weight

6 kg (13.23 lb.)

Other Conditions

Media such as the following cannot be used.

• Media whose end is attached to the paper tube (core)

• Media that is severely warped or that has a strong tendency to reroll

• Media that cannot withstand the heat of the media heating system

• Media whose paper tube (core) is bent or crushed

• Media that bends under its own weight when loaded

• Media on a sagging roll

• Media that is rolled unevenly

About the Media Used
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The following four output methods are available for this machine.

Printing (Only) Printing using ink. It is also called "Printing Only" to distinguish from "Printing and Cutting."

Cutting (Only) Cutting using a blade such as for seal die cutting. It is also called "Cutting Only" to distinguish from
"Printing and Cutting."

Printing and Cutting Printing method in which printing is followed by cutting. If output data that contains both printing
and cutting information is sent to the printer, the cutting operation starts after printing finishes.

Crop-Cut
Output method using "Crop Marks" to align the printing and cutting results. If you are printing on
the media, removing it so it can be laminated, and then reloading the media in the machine to cut
it, use the crop marks to align the media.

Important Points During Use

Use the machine periodically

We recommend using the machine at least once a week. If left unused for a long period of time, the ink
may settle, resulting in unstable discharge (and nozzle clogging). Any dry ink will need to be discharged.

Four Different Output Methods
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Precautions When Operating the Power Supply

Make sure that the main power is on at all times
Never switch the main power off. Continuous power on allows the automatic maintenance function to work periodically.
Failure to ensure automatic maintenance will result in a malfunction of the machine, such as damaged print heads.
During operation, never unplug or switch the main power off.
During operation, if the main power is switched off, or unplugged, the print heads may be damaged. The sub power
switch must always be turned off before the main power is switched off. To turn off the sub power switch, press and
hold down the [POWER] key. If accidentally the main power is switched off, immediately switch the main power and sub
power ([POWER] key) back on again.

IMPORTANT

Turning the Power On

Remove any loaded media or switch off the sub power when printing is not being performed.
The continued application of heat at a single location may cause the release of toxic gases from the media or pose a
fire hazard.

WARNING

Procedure

1. Close the front cover.

2. Turn on the main power switch.

3. Press the [POWER] key.

When the [POWER] key indicator changes from flashing to steady, startup is finished.

Switching Power On and Off
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Switching Power On and Off
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Switching the Power Off (Sub-power Off)

Procedure

1. When output is completed, press and hold down the [POWER] key for one second or more.

When the [POWER] key light is off, the power is off.

2. Push the loading lever backward.

Even if you are not going to switch the power off when the machine is not in use, make sure the
loading lever is moved to the rear.

About Sleep Mode (Power-Saving Mode)

The machine has a power-saving function; after about 30 minutes of non-use the machine automatically
changes to the lower power consumption sleep mode. In the sleep mode, the [POWER] key slowly flashes
on and off. When you next operate the [POWER] key or send print data from a computer to the machine
with media loaded, the machine returns to the regular mode.

Switching Power On and Off
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This section describes operations when printing only.

Refer to Cutting / Printing and Cutting(P. 40), Performing Printing and Cutting Separately(P. 49).

Step 1: Loading Media

Loading Roll Media

Procedure

1. Move the left media guide to the left edge.

(1) Push the loading lever ( ) backward.

(2) Move the left media guide ( ) to the left.

2. Attach the media flange ( ) to one end of the media bar ( ).

Insert the side of the media bar with a hole ( ) into the media flange. When loading roll media
with a 3-inch paper tube inner diameter, attach the media flange with ( ) on the inside. When
loading roll media with a 2-inch paper tube inner diameter, attach the media flange with ( ) on
the inside.

3. Secure the media flange and media bar with the mounting pin ( ).

Printing
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4. Load the roll media onto the media flange.

Install the roll media so there is no gap between it and the media flange.

Place the secured media flange at the bottom, so that the media feeds in the clockwise direction when viewed
from above. You cannot load the media correctly if the feed direction is incorrect.

MEMO

5. Place the roll media loaded onto the media bar on the printer.

Press both ends of the media bar into the grooves at the back of the printer while making sure the
media does not become loose.

Printing
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6. Adjust the loaded position of the roll media.

(1) Move the roll media to the right so the media flange ( ) touches the right media guide ( ).

(2) Slide the left media guide ( ) and press it against the media flange.

7. Pass the media through the printer.

Pull the media straight to keep it taut, and then pass it beneath the media clamps ( ).

Not OKOK

The pinch rollers cannot be moved directly by hand. Move them with the media guide.
Attempting to forcibly move these rollers may result in injury.

CAUTION

8. As shown in the figure, pass the media under the front cover and pull the media out the other side.

Printing
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9. Start initial operation.

(1) Make sure the left media guide ( ) is pressed against the media flange.

(2) Close the front cover ( ).

(3) Pull the loading lever ( ) forward.

Pull the loading lever forward to start initial operation. When the [POWER] key indicator
changes from flashing to steady, initial operation is complete.

Printing
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Loading Sheet Media

Procedure

1. Move the left media guide to the left edge.

(1) Push the loading lever ( ) backward.

(2) Move the left media guide ( ) to the left.

2. Install the sheet media.

(1) Move the media to the right so it touches the right media guide.

(2) Slide the left media guide so it touches the media.

(3) Pass the media through the printer.

Pull the media straight to keep it taut, and then pass it beneath the media clamps ( ).

Printing
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Not OKOK

The pinch rollers cannot be moved directly by hand. Move them with the media
guide.
Attempting to forcibly move these rollers may result in injury.

CAUTION

3. As shown in the figure, pass the media under the front cover and pull the media out the other side.

4. Start initial operation.

(1) Make sure the left media guide ( ) is pressed against the media flange.

(2) Close the front cover ( ).

(3) Pull the loading lever ( ) forward.

Pull the loading lever forward to start initial operation. When the [POWER] key indicator
changes from flashing to steady, initial operation is complete.

Printing
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Printing
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Step 2: Bidirectional Adjustment

Perform adjustment in the following situations. You do not need to perform adjustment in other situations.
Go to Step 3: Printing Tests and Normal Cleaning(P. 31).

• When using this machine for the first time

• When changing the media to use for the first time

What are bidirectional printing and bidirectional adjustment?

This machine can perform "Bidirectional Printing," which means that the print heads print when moving
in both directions. Bidirectional printing offers the advantage of being able to shorten output times, but
subtle misalignment occurs during the outbound and return passes. The operation to correct these mis-
alignments is called "Bidirectional Adjustment".

BN-20 Driver: How to Perform Bidirectional Printing

Procedure

1. Display the BN-20 driver's Printing Preferences dialog box.
P. 11Displaying the BN-20 Driver's Printing Preferences Dialog Box

2. Select [CMYK (v)] from [Ink Mode] on the [Settings] tab.

3. Select the [Bidirectional Printing] check box.

Printing
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VersaWorks: How to Perform Bidirectional Printing

Bidirectional printing occurs when "Draft" is selected for the print quality in VersaWorks. For details on
how to set the printing quality, refer to [Output Settings]>[Setting the Printing Quality] in the VersaWorks
Help.

Procedure

1. Open the Utility window.

P. 12Starting/Exiting Utility

2. Click [Bidirectional adjustment].

3. Click [Test Print].

A test pattern is printed.

4. Follow the on-screen instructions and enter the value for [New Value].

5. Click [Apply].

The value in [Current Value] changes to the entered value.

6. Click [Close].

Printing
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Step 3: Printing Tests and Normal Cleaning

Procedure

1. Open the Utility window.

P. 12Starting/Exiting Utility

2. Click [Check Nozzle Condition].

3. Click [Test Print].

A test pattern is printed. Follow the on-screen instructions to check for nozzle drop-out.

• Nozzle drop-out is present. -> Proceed to step 4.

• No nozzle drop-out is present. -> Click [Close] to finish the procedure.

4. Select the [Normal Cleaning], and then click [Go].

Normal cleaning starts.

Printing
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5. Check for nozzle drop-out again.

If the nozzle drop-out is not fixed, perform [Normal Cleaning] again. For information about [Medi-
um Cleaning] and [Powerful Cleaning], refer to the following topic.

 RELATED LINKS 

・  P. 73Medium/Powerful Cleaning

Printing
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Step 4: Correcting the Media Feed

Procedure

1. Open the Utility window.

P. 12Starting/Exiting Utility

2. Click [Calibrate Sheet Feeding].

3. Click [Test Print].

A test pattern is printed.

4. Follow the on-screen instructions and enter the value for [New Value].

5. Click [Apply].

The value in [Current Value] changes to the entered value.

6. Click [Close].

Printing
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Step 5: Starting Print Output

Procedure

1. Prepare the print data.

2. Output the print data.

• When outputting from commercial application software for creating drawings

Refer to the documentation supplied with your application software.

• When outputting from VersaWorks

Refer to the [VersaWorks Help]>[Basic Operations for Output].

3. Cut the media when outputting is complete.

Output Is Not Possible in These Situations

• The machine does not run when a cover (front, or maintenance) is open.
• This machine does not complete startup until the heater reaches the specified temperature, and does not

accept any operation.
When the ambient temperature is low, the heater is slow to warm up. Use the machine in an environment
where the temperature is 20 to 32° C (68 to 90° F).

• Output is not performed when [POWER] key does not stay steadily lighted. After the media is loaded, pull
the loading lever. When the [POWER] key flashes, no operation except for canceling output is accepted.

• If you send the output data in a state where there is no ink left, a warning buzzer will sound and the ma-
chine will stop temporality. A message indicating that ink has run out is displayed in the Status field of Util-
ities. When the ink cartridge is replaced with a new one, printing or cutting starts.

Points that must be observed

• Never open a cover (front, or maintenance) while output is in progress. Doing so interrupts printing.
• When you are performing printing, clamp the edges of the media with the media clamps. Otherwise, the

edges of the media may warp and catch on the print heads.
• During output, do not touch the media. Doing so may obstruct the media feed or cause the media to rub

against the print heads, which may result in a paper jam or damage to the heads.
• Keep the loading lever raised when the machine is not in use.

When not using the machine, remove any media and store it in a suitable environment.

• If the machine is left with the media loaded, the media may be damaged, which may adversely affectprint-
ing. When not using the machine, remove any media and store it in a suitable environment.

IMPORTANT

Printing
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The output-start location is always the point shown in the figure below.

Printing area

Right pinch roller

Output-start location

Blade protector

A 1.4 mm (0.06 in.)

B 5 mm (0.2 in.)

Output-start Location
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To stop output on the printer side

Procedure

1. Press and hold down the [POWER] key for one second or more during output.

Output stops. You cannot resume output from the stop point.

2. Press the [POWER] key to turn the machine on.

This operation does not cancel standby output data on the computer. Follow the steps below to
cancel data that is still on the computer.

 RELATED LINKS 

・  P. 36Stopping Output on the Computer Side

Stopping Output on the Computer Side

Procedure

1. Open the [Devices and printers] window.

• Windows 11

From the Start menu, click [All apps]>[Windows Tool]>[Control Panel]>[View devices and
printers].

• Windows 10

From the Start menu, click [Windows System]>[Control Panel]>[View devices and printers].

2. Double-click the BN-20 icon.

Stopping Print Output

36  Basic Operations



3. Click [Printers]>[Cancel All Documents].

Depending on the computer data transfer status, it may be too late to cancel output. In this case,
you need to cancel output from the printer.

Stopping Print Output
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Adjusting Cutting

Adjust the cutting conditions to obtain clear cutting lines. Make adjustments to match the media thick-
ness.

Procedure

1. Load the media to be cut.

P. 22Step 1: Loading Media

2. Open the Utility window.

P. 12Starting/Exiting Utility

3. Click [Cut Adjustment].

4. Click [Test Cut].

A cutting test is performed.

5. Enter the [Cut Force][Cut Speed][Cut Times].

[Cut Force]

This is the force of the blade during cutting. If this force is too strong, the blade cuts into the
backing paper. (Default setting: 50 gf)

Cutting / Printing and Cutting
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[Cut Speed]

This is the speed of the blade during cutting. If this speed is too fast, the cutting line will be
crooked. (Default setting: 15 cm/sec.)

[Cut Times]

This is the number of times to cut the same location. If cutting is not possible even after adjust-
ing the force and speed of cutting, increase the number of cuts. (Default setting: 1)

Check item Result Setting item Adjustment

Check the shape. The cut shape is distorted. [Cut Speed] Reduce

Peel off the circle.
The square also peels off. [Cut Force] Increase

Some uncut areas remain. [Cut Speed] Reduce

Peel off the square.

The blade leaves faint traces on the backing
paper.

[Cut Force]

No change

The blade trace is indistinct. Increase

The blade trace is too deep and cuts into the
backing paper. Reduce

6. Click [Apply].

Repeatedly perform [Test Cut] and make adjustments until the appropriate adjustments are ob-
tained.

7. Click [Close].

Cutting / Printing and Cutting
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Accurately Adjusting the Cutting-in Amount

When you want to perform accurate and fine adjustment of the cutting-in amount ( ), such as when cut-
ting media with thin backing paper, you can obtain good results by adjusting the tip of the blade. Turn the
cap portion of the blade holder to adjust the amount of blade extension. Each indicator tick corresponds
to 0.1 millimeters, and adjustment for 0.5 millimeters can be made by rotating the cap one full turn.

Note that making the amount of blade extension too small may cause the tip of the blade holder cap to
touch, and may soil and damage the printed surface. It's important to be especially careful about this
when you're using media that has poor ink adhesion properties.

The amount of blade extension ( ) is 0 mm ( ) at minimum and 2.5 mm (98.4 mil) ( ) at maximum.

Rough Estimate for the Amount of Blade Extension

Set the amount of blade extension ( ) to an amount that is the sum of the thickness of the material por-
tion ( ) and half ( ) the thickness of the backing paper ( ).

Cutting / Printing and Cutting
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Print and Cut Adjustment

When performing both printing and cutting, adjust and align the printing and cutting positions. Depending
on the media thickness, sometimes printing and cutting positions are very slightly out of alignment. We
recommend that you make corrections to match the media you are using.

Procedure

1. Load the media to be cut.

P. 22Step 1: Loading Media

2. Open the Utility window.

P. 12Starting/Exiting Utility

3. Click [Print and Cut Adjustment].

4. Click [Print and Cut Pattern].

A test pattern is printed.

5. Follow the on-screen instructions and enter the corrected values for [New Scanning Value] and [New
Feeding Value].

6. Click [Apply].

The values in [New Scanning Value] and [New Feeding Value] change to "0."

Cutting / Printing and Cutting
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7. Click [Close].

Cutting / Printing and Cutting
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Creating Data for Cutting / Printing and Cutting

When using VersaWorks, refer to the [VersaWorks Help].

When using application software to create drawings

Verified application software

• Adobe Illustrator : after CS6

• CorelDRAW : after X3

1. Set the color that the BN-20 driver will identify as the cutting line.

Procedure

1. Display the BN-20 driver's Printing Preferences dialog box.
P. 11Displaying the BN-20 Driver's Printing Preferences Dialog Box

2. Click the [Line Color] button from [CutLine Selection] on the [Printer Adjustment] tab.

The [Color] dialog box opens.

3. Click [Define Custom Colors].

The Color Settings dialog box opens, allowing you to create colors.

Cutting / Printing and Cutting
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4. Enter values for [Red], [Green], and [Blue].

The BN-20 driver identifies the color specified using the values entered here as the cutting line and
outputs the color.

Cutting / Printing and Cutting
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2. Creating print data

Procedure

1. Create the print data using application software for creating drawings.

Set the Document Color Mode to [RGB]. The color (RGB value) specified as the cutting line may change be-
cause CMYK is converted to RGB when outputting in CMYK mode.
In this case, it may not be possible to perform cutting because the color specified for the driver as the cutting
line and the color output from the application software differ.

MEMO

2. Specify the RGB value set for the part to be identified as the cutting line in step 1. - 4.

If the color for the part you want to print and the color set in step 1. - 4 overlap, redo the settings
from step 1. - 4.

3. Specify the line width for cutting lines as follows.

It may not be possible to cut lines of the specified width.

MEMO

• Adobe Illustrator : 0.001 pt

• CorelDRAW : Hairline

Cutting / Printing and Cutting
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Cautionary Notes on Making Output with Cutting

Points to Note When Cutting Only

For roll media, let the media hang down to the rear before outputting.

When using roll media and only performing cutting, let the media hang down to the rear of the machine.
This prevents motor errors and the roll falling from the machine due to the media being pulled with exces-
sive force.

Do not cut the media before it is pulled back if "Take back after printing" is specified in the BN-20
driver.

Do not cut the media before it is pulled back when the [Rewind Media After Printing] check box is select-
ed in the [Printer Adjustment] tab of the BN-20 driver.

When the [Rewind Media After Printing] check box is selected, the media is pulled back after printing. If
the media is cut before it is pulled back, ink might be discharged to a location where there is no media.

When you are performing printing and cutting, allow the ink to dry sufficiently before starting cut-
ting.

You can set the time for the printer to wait before cutting (Dry Time) with the BN-20 driver or VersaWorks.
The drying time varies according to the media.

 RELATED LINKS 

・  P. 56Setting of Dry Time
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To Perform Printing and Cutting Separately

You can remove the printed media and then reload it and perform cutting.

(Example: Perform lamination or other processing after printing, then reload the media and perform cut-
ting.)

Then, carry out alignment to prevent misalignment of the printing results and the cut lines. Perform this
adjustment in the next Procedure.

Procedure

1. Printing with Crop Marks.

P. 50Printing with Crop Marks

2. Align to the printed crop marks and perform cutting.

P. 52Cutting by Automatically Aligning the Position

Media Sizes Allowing Automatic Crop Mark Detection

Pinch roller

Crop mark

A 65 mm (2.56 in.) or more

B 22.5 mm (0.89 in.)

C 1.4 mm (0.06 in.)

D 60 mm (2.37 in.) or more

Performing Printing and Cutting Separately
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Printing with Crop Marks

This section explains how to specify settings when using the BN-20 driver. When using VersaWorks, refer to
the[VersaWorks Help].

Procedure

1. Display the BN-20 driver's Printing Preferences dialog box.
P. 11Displaying the BN-20 Driver's Printing Preferences Dialog Box

2. On the [Printer Adjustment] tab, select the [CropMark] check box.

3. Select [Print].

When [Printing & Cut] is selected, the media is pulled back after printing with crop marks is per-
formed, and then cutting starts immediately. The printer detects the crop marks to perform cut-
ting.

Before you start printing, check the media size on the [Settings] tab on the Printing Preferences dialog box
and write it down. If the media size during cutting is not set to the same size as that used during printing, the
cutting lines may be misaligned compared to printing.

IMPORTANT

4. Click [OK].

5. Start printing.

P. 34Step 5: Starting Print Output

The crop marks are printed as shown in the figure.

Performing Printing and Cutting Separately
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  : Align points

(B): Base point

Alignment marks and symbols drawn using graphics software cannot be used as crop marks.

IMPORTANT

Performing Printing and Cutting Separately
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Cutting by Automatically Aligning the Position

This section explains how to specify settings when using the BN-20 driver. When using VersaWorks, refer to
the[VersaWorks Help].

Procedure

1. Print with crop marks, remove the media, and then reload it.

Points for Media Setting

Place the crop marks ( ) on the blade protector ( ).

Ensure that the angle is less than 5 degrees. Failing to do so will make alignment impossible.

2. Display the BN-20 driver's Printing Preferences dialog box.
P. 11Displaying the BN-20 Driver's Printing Preferences Dialog Box

3. On the [Printer Adjustment] tab, select the [CropMark] check box.

Performing Printing and Cutting Separately
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4. Select [Cut].

Before you start cutting, check that the media size on the [Settings] tab on the Printing Preferences dialog
box is the same as the size used for printing. If the media size during cutting is not set to the same size as that
used during printing, the cutting lines may be misaligned compared to printing.

IMPORTANT

5. Start cutting.

P. 34Step 5: Starting Print Output

 RELATED LINKS 

・  P. 50Printing with Crop Marks
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Crop Cut Adjustment

Depending on the composition of the media, the positioning of printing and cutting may be misaligned
even when you are using crop marks. Make corrections for misaligned printing and cutting for the media
you are using.

Procedure

1. Open the Utility window.

P. 12Starting/Exiting Utility

2. Click [CropCut Adjustment].

3. Click [Print and Cut Pattern].

A test pattern is printed.

4. Follow the on-screen instructions and enter the values for [New Scanning Value] and [New Feeding Val-
ue].

5. Click [Apply].

The values in [New Scanning Value] and [New Feeding Value] change to "0."

6. Click [Close].

Performing Printing and Cutting Separately
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Performing Various Adjustments Through a Sequence of Operations

You can perform various output adjustments through a sequence of operations by clicking [Adjust All] on
the [Adjustment] tab. The adjustment method is the same as when adjusting settings individually.

Click [Adjust All] to display the screen shown in this figure.

[Next]: Continues to the screen for the adjustment currently displayed on the screen.

[Skip]: Skips the adjustment currently displayed on the screen.

[Cancel]: Cancels the adjustment process.

The adjustments vary depending on the output method. Refer to the table below.

Printing (Only) Cutting (Only) Printing and Cutting Crop-Cut

Check Nozzle Condition ✓ - ✓ ✓

Bidirectional adjust-
ment*1 ✓ - ✓ ✓

Calibrate Sheet Feeding ✓ ✓ ✓ ✓

Cut Adjustment - ✓ ✓ ✓

Print and Cut Adjust-
ment - - ✓ ✓

Crop Cut Adjustment - - - ✓

 

*1 This is available when bidirectional printing is set in the BN-20 driver or VersaWorks.
 

Utility : Other Function

Optimizing the Output Quality 55



Setting of Dry Time

This section explains the method of setting the time that the printer needs to wait before it starts printing
or cutting the next page.

Especially, in the case of printing and cutting, ink needs to be sufficiently dried before cutting is started.

When you make output via the BN-20 driver using a general drawing applica-
tion

Make the following setting in the BN-20 driver first, and then make output from the application.

Procedure

1. Open the [Devices and printers] window.

• Windows 11

From the Start menu, click [All apps]>[Windows Tool]>[Control Panel]>[View devices and
printers].

• Windows 10

From the Start menu, click [Windows System]>[Control Panel]>[View devices and printers].

2. Right-click the [Roland BN-20] icon, and then click [Printing preferences].

The BN-20 driver's Printing Preferences dialog box opens.

3. Set the drying time.

(1) Select [Dry Time] on the [Printer Adjustment] tab.

The appropriate setting time varies according to the media. Set a longer time when you use
media on which it takes time to dry ink.

(2) Click [OK].

When the printer starts drying, the remaining dry time is displayed in Utility.

Utility : Other Function
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When you make output from VersaWorks

You can set the dry time in VersaWorks as well. For information on its setting method, refer to [Versa-
Works Help].

When you set the dry time in VersaWorks, if [Use Printer Settings] is set, 0 is set to the dry time. You should note that
the setting in the BN-20 driver is not reflected.

IMPORTANT

Utility : Other Function
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Resetting All Adjustments to Factory Default Values

Click [Factory Reset] on the [Option] tab of Utility to reset all the Utility settings to their factory default
values.

When you click [Factory Reset], the message shown in the figure is displayed. Click [Yes] to reset the set-
tings.

Utility : Other Function
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Automatic Maintenance Function: Points to Note

This machine has a function to automatically perform periodical maintenance tasks, e.g. to prevent the
print heads from drying out. To ensure the maintenance is properly carried out, please observe the follow-
ing points:

• Make sure that the main power is on at all times.

• Do not leave the front cover and maintenance cover open.

Maintenance Schedule

Daily maintenance

To keep this machine in tip-top condition, make sure that daily maintenance is actually performed every
day.

Periodical maintenance

To maintain reliable output conditions, some maintenance tasks need to be carried out at least once a
month.

Switch the sub power on at least every 2 weeks

Switch the sub power on at least every 2 weeks. When the sub power is on, operations to prevent the
print heads from drying out are automatically performed. If the machine is not used for a long period of
time, print heads may be damaged. It is important o make sure to include this task in your maintenance
schedule.

Maintain the temperature and humidity within the specified range

Even when the machine is not in use, maintain the temperature between 5 to 40°C (41 to 104 °F), with
a relative humidity of 20 to 80%, with no condensation. Failure to keep the temperature and humidity
within the specified range may cause a machine malfunction.

 RELATED LINKS 

・  P. 67Daily Maintenance

・  P. 72Periodical Cleaning Maintenance

When Not in Use for a Prolonged Period

In advance, insert ink cartridges that have a large amount of ink remaining.

If the ink runs out, the machine will not be able to periodically perform automatic maintenance. If the
machine is left in this state, the print heads may malfunction. If you know that you will not use the
machine for a prolonged period, insert ink cartridges that have a large amount of ink remaining.

Replace the waste cartridge in advance of prolonged periods of disuse.

If you know that you will not use the machine for a prolonged period, follow the procedure below to
replace the drain cartridge. For information about purchasing drain cartridges, contact your authorized
Roland DG Corp. dealer.

Do not reuse drain cartridges. Doing so makes it impossible to manage the amount of discharged fluid, which may over-
flow.

IMPORTANT

Important Notes on Handling and Use
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 RELATED LINKS 

・  P. 69Replacing the Drain Cartridge
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Checking for Remaining Ink

Ink levels can be checked in the Ink tab of the Utility window. A simple bar scale indicates the level of ink
in each cartridge. Percentage values also indicate the level of ink remaining. When the ink cartridge is re-
moved, "No Cartridge" is displayed.

• MG: Magenta

• CY: Cyan

• YE: Yellow

• BK: Black

* The display shows approximately how much ink remains. It may differ somewhat from the actual amount
remaining.

When an ink level is low, a message appears on the Utility icon in the notification area. Check the ink that
is running out in the Utility window and prepare a relevant cartridge for replacement.

Checking Ink Levels and Replacing
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How to Replace the Ink Cartridge

When ink runs out, a warning beep sounds and printing pauses. Pull out the empty cartridge and insert a
new one. Printing resumes.

The precipitation of the ingredients in the ink disables printing in normal color. So that the ink mixes well,
shake each ink cartridge 50 times (about 20 seconds) horizontally with a stroke length of around 5 cm
(1.97 in.) from each end of the ink cartridge before inserting it.

Important notes on replacing cartridges

• Replace the cartridge with an item of identical type and color.

• Insert the cartridge so that the side with the arrow faces up.
• Insert and remove cartridges slowly, one at a time.
• Insert the cartridge firmly, as far as it will go.

• Never mix different types of items.
• Never leave the machine with an ink cartridge removed. The print heads may become clogged.
• Never insert or remove a partially used ink cartridge with undue force.
• Never remove an ink cartridge suddenly while the printer is in operation.

IMPORTANT

Never store ink, cleaning liquid, or discharged fluid in any of the following locations.

• Any location exposed to open flame

WARNING

Checking Ink Levels and Replacing
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• Any location where high temperature may occur

• Near bleach or any other such oxidizing agent or explosive material

• Any location within the reach of children
Fire may be a danger. Accidental ingestion by children may pose a health hazard.

Checking Ink Levels and Replacing
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Maintenance of Ink Cartridges

The ink ingredients have a tendency to separate and settle. Allowing the ink to stand can cause the settled
material to harden, resulting in malfunction or other problems.

So that the ink mixes well, periodically shake each ink cartridge 50 times (about 20 seconds) horizontally
with a stroke length of around 5 cm (1.97 in.) from each end of the ink cartridge before reinserting it.

Cleaning

Never use gasoline, alcohol, thinner, or any other flammable material.
Doing so may cause a fire.

WARNING

Wipe away any ink or grime on the media path and other areas as part of the daily cleaning procedure.
Pinch rollers, grit rollers, and the platen are particularly prone to the buildup of grime. Wipe away any
buildup of ink or grime on the media path. Clean by wiping with a cloth moistened by neutral detergent
diluted with water then wrung dry.

• This machine is a precision device and is sensitive to dust and dirt. Perform cleaning on a daily basis.
• Never attempt to oil or lubricate the machine.

MEMO

Daily Maintenance
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Grit roller Remove buildup of media scraps and other material using a brush. Never
use a metal brush.

Pinch roller Periodically wipe away any grime. Failure to clean this part properly may
result in the transfer of grime to the surface of media.

Platen Wipe away any buildup of ink or grime on the media path.

Daily Maintenance
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Replacing the Drain Cartridge

When the drain cartridge is filled with discharged fluid, the Utility window automatically opens and dis-
plays a message in the Status field that prompts the replacement of the cartridge. Follow the message's
instructions and prepare a replacement drain cartridge or replace the cartridge.

Before you remove the drain cartridge, wait for a message to be displayed in the utility.
Failing to follow this procedure may cause discharged fluid to flow out of the tube and spill, soiling your hands or the
floor.

CAUTION

If you know that you will not use the machine for a prolonged period, follow the procedure below to re-
place the drain cartridge.

Never place the drain cartridge or ink near an open flame.
Doing so may cause a fire.

WARNING

Do not open the lid on the drain cartridge.
Any spillage or vapor leakage may cause fire, odor, or physical distress.

CAUTION

Procedure

1. Remove the drain cartridge.

2. Insert a new drain cartridge.

Daily Maintenance
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3. When the dialog box shown below is displayed, click [Yes].

Do not reuse drain cartridges.
Doing so makes it impossible to manage the amount of discharged fluid, which may overflow.

IMPORTANT

Dispose of discharged fluid properly, in accordance with the laws in effect in your locale.
Discharged fluid is flammable and contains toxic ingredients. Never attempt to incinerate discharged fluid or
discard it with ordinary trash. Also, do not dispose of it in sewer systems, rivers, or streams. Doing so may
have an adverse impact on the environment.

IMPORTANT

For information about purchasing drain cartridges, contact your authorized dealer.

Daily Maintenance
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Care and Maintenance of the Print Heads

To ensure optimum printing, the print heads need to be maintained in good condition. There are two kinds
of maintenance: daily maintenance and periodical maintenance.

Daily care and maintenance

Normal Cleaning

We recommend performing Normal Cleaning everyday before the start of operations.
P. 31Step 3: Printing Tests and Normal Cleaning

Periodical care and maintenance

P. 72Periodical Cleaning Maintenance

* Print heads are consumable parts and subject to wear. Depending on the frequency of use, periodical re-
placement is required. Please order them directly from us or your authorized Roland DG Corp. dealer.

Daily Maintenance
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Periodic Cleaning Menus

This machine has several cleaning menus. Perform the appropriate level of cleaning in accordance with the
ink type, the cleaning period, and the machine condition.

When Using ECO-SOL MAX/ECO-SOL MAX 2 Ink

Normal cleaning
Carry out a printing test before the start of work each day. If nozzle drop-out occurs, perform this
cleaning. 

P. 31Step 3: Printing Tests and Normal Cleaning

Medium cleaning If you cannot fix nozzle drop-out with normal cleaning, try medium cleaning. If medium cleaning
does not fix the problem, perform powerful cleaning. 

P. 73Medium/Powerful CleaningPowerful cleaning

Manual cleaning
Perform manual cleaning periodically according to the frequency of use. To maintain stable output
conditions at all times, perform manual cleaning more than once a month. 

P. 75Manual Cleaning

When Using ECO-SOL MAX 3 Ink

Normal cleaning
Carry out a printing test before the start of work each day. If nozzle drop-out occurs, perform this
cleaning. 

P. 31Step 3: Printing Tests and Normal Cleaning

Manual cleaning

The message [Clean the printer manually.] is displayed approximately once per week, but it may
be displayed more frequently depending on the usage conditions. When this message is displayed,
be sure to perform manual cleaning. 

P. 75Manual Cleaning

Medium cleaning If you cannot fix nozzle drop-out with normal cleaning, try medium cleaning. If medium cleaning
does not fix the problem, perform powerful cleaning. 

P. 73Medium/Powerful CleaningPowerful cleaning

Manual cleaning

Perform manual cleaning periodically according to the frequency of use. To maintain stable output
conditions at all times, perform manual cleaning more than once a month. 

P. 79Replacing the Wiper
P. 81Replacing the Felt Wiper

Periodical Cleaning Maintenance
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Medium/Powerful Cleaning

If problems such as nozzle drop-out persist even after you have performed normal cleaning, carry out the
more powerful [Medium Cleaning] two or three times. If this still does not resolve the problem, carry out
the even more forceful [Powerful Cleaning].

Medium cleaning consumes more ink than normal cleaning. Powerful cleaning consumes more ink than medium clean-
ing. Because the print heads are prone to damage if cleaned too frequently, do not perform cleaning more than neces-
sary.

MEMO

Procedure

1. Open the Utility window.

P. 12Starting/Exiting Utility

2. On the [Adjustment] tab, select [Medium Cleaning] and click [Go].

3. Click [Check Nozzle Condition].

4. Click [Test Print].

Periodical Cleaning Maintenance
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A test pattern is printed. Follow the on-screen instructions to check for nozzle drop-out.

• Nozzle drop-out is present. -> Proceed to step 5.

• No nozzle drop-out is present. -> Click [Close] to finish the procedure.

5. Select the [Medium Cleaning], and then click [Go].

Medium cleaning starts.

6. Check for nozzle drop-out again.

If nozzle drop-out is not fixed by [Medium Cleaning], perform [Powerful Cleaning].

If problems such as nozzle drop-out persist even after you have performed powerful cleaning several times,
perform [Manual Cleaning].

MEMO

 RELATED LINKS 

・  P. 75Manual Cleaning
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When Manual Cleaning Is Necessary

The timing with which manual head cleaning is required varies depending on the type of ink you are using.
Be sure to perform this cleaning with the required timing.

P. 72Periodic Cleaning Menus

Manual cleaning is recommended when the following symptoms occur.

When any of the following symptoms occur and cannot be solved by automatic cleaning functions such as
normal cleaning, perform manual cleaning.

Wiper replacement may also be effective in improving these symptoms.

Nozzle drop-out Ink drips Dragging dirt

Dust or other foreign matter adheres to
the print heads and impedes correct ink
discharge.

Ink pools in dust or dirt adhered to the
print heads, and drips onto the media.

The phenomenon where dirt or dust accu-
mulates on the print heads.

• When the cleaning stick and cleaning liquid used for manual cleaning runs out, purchase them from your authorized
dealer.

• The print heads are components that wear out. Periodic replacement is required, with the frequency of replacement
depending on use. Contact your authorized dealer.

MEMO

 RELATED LINKS 

・  P. 79Replacing the Wiper
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Manual Cleaning Method

Important notes on this procedure

• Before attempting this operation, remove any media.
• To prevent the heads from drying out, finish this procedure in 30 minutes or less. An alarm sounds after 30 minutes.
• Never use any implements other than the included cleaning sticks. Cotton swabs or other lint-producing items may

damage the heads. If you use up the cleaning sticks, contact your authorized dealer.
• Use one cleaning stick per cleaning session, and then discard the stick after use. Reusing cleaning sticks may reduce

print quality.
• Do not put a cleaning stick that has been used for cleaning into the cleaning liquid. Doing so will deteriorate the

cleaning liquid.
• Never rub the nozzle surface of the heads.
• Stroke the sponges very gently, applying as little pressure as possible. Never rub, scrape, or crush them.

When an alarm sounds during cleaning
To prevent the print heads from drying out, an alarm sounds about 30 minutes after the start of the operation. Perform
the operation by following the message displayed in the Utility window.

IMPORTANT

Be sure to perform operations as specified by the instructions, and never touch any area not
specified in the instructions.
Sudden movement of the machine may cause injury.

WARNING

Procedure

1. Open the Utility window.

P. 12Starting/Exiting Utility

2. On the [Adjustment] tab, click [Manual Cleaning].

The manual cleaning procedure is displayed. Carefully read the on-screen instructions and carry
out the work.

Manual Cleaning
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3. Perform a printing test to check the results.

Perform cleaning using the machine's cleaning feature several times when necessary.

 RELATED LINKS 

・  P. 31Printing Tests and Normal Cleaning
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Replacing the Wiper

The wiper is a component that is used for cleaning the print heads. When the message appears on the Util-
ity icon in the computer's notification area, it is time to replace the wiper with a new one. Replace with
new items. For information about purchasing wipers, contact your authorized dealer.

When an alarm sounds during wiper replacement

To prevent the print heads from drying out, an alarm sounds about 30 minutes after the start of the opera-
tion. Perform the operation by following the message displayed in the Utility window.

Be sure to perform operations as specified by the instructions, and never touch any area not
specified in the instructions.
Sudden movement of the machine may cause injury.

WARNING

Procedure

1. Open the Utility window.

P. 12Starting/Exiting Utility

2. On the [Replace Tools] tab, click [Replace Wiper].

A procedure for replacing the wiper is displayed. Carefully read the on-screen instructions and car-
ry out the work.

Replacing Parts for Maintenance
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3. When the operation is completed, close the front cover.

Replacing Parts for Maintenance
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Replacing the Felt Wiper

The felt wiper is a component that is used for cleaning the print heads. When the message appears on the
Utility icon in the computer's notification area, it is time to replace the wiper with a new one. Replace
with new items. For information about purchasing felt wipers, contact your authorized dealer.

When an alarm sounds during felt wiper replacement

To prevent the print heads from drying out, an alarm sounds about 30 minutes after the start of the opera-
tion. Perform the operation by following the message displayed in the Utility window.

Be sure to perform operations as specified by the instructions, and never touch any area not
specified in the instructions.
Sudden movement of the machine may cause injury.

WARNING

Procedure

1. Open the Utility window.

P. 12Starting/Exiting Utility

2. On the [Replace Tools] tab, click [Replace Felt Wiper].

A procedure for replacing the felt wiper is displayed. Carefully read the on-screen instructions and
carry out the work.

Replacing Parts for Maintenance
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3. When the operation is completed, close the front cover.

Replacing Parts for Maintenance
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Replacing the Blade

If the blade becomes dull, if the edge of the blade is chipped, or if the cutting quality is lowered, replace
the blade with a new blade.

Be sure to perform operations as specified by the instructions, and never touch any area not
specified in the instructions.
Sudden movement of the machine may cause injury.

WARNING

Never touch the tip of the knife.
Doing so may result in injury. The cutting performance of the blade will also be impaired.

CAUTION

Procedure

1. Open the Utility window.

P. 12Starting/Exiting Utility

2. On the [Replace Tools] tab, click [Replace Tools].

When the screen shown in the figure appears, open the front cover and replace the blade.

3. Remove the blade holder.

Replacing Parts for Maintenance
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4. Replace the blade.

(1) Press the pin (A).

(2) Remove the old blade (B).

(3) Install a new blade (C).

5. Support the screw from below and insert the blade holder.

Failure to do this may adversely affect the cutting quality.

6. Tighten the screw.

Tug the blade holder upward to make sure it does not come loose.

Replacing Parts for Maintenance
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7. Close the front cover.

Click [Close].

This completes the replacement procedure.

8. Make adjustments for cutting.

 RELATED LINKS 

・  P. 40Adjusting Cutting

Replacing Parts for Maintenance

Replacing Consumable Parts 85



Troubleshooting Methods.

86



Output Quality Problems
Printed results are coarse or contain horizontal stripes..........................................88

Do the print heads show nozzle clogging? ....................................................88
Have you carried out[Calibrate Sheet Feeding] ? ..........................................88
Have you carried out [Bidirectional adjustment] ? ........................................88
Is the temperature of the room too low?.....................................................88
Is the printer installed in a level and stable location? .....................................88
Is the printer installed in a location out of direct sunlight? ...............................88
Is the media loaded and set up correctly? ...................................................88

Colors are unstable or uneven........................................................................90
Did you shake the ink cartridges gently before installing them? .........................90
Is the media wrinkled? ..........................................................................90
Is the printer installed in a level and stable location? .....................................90
Is the printer being used in a location subject to severe changes in the oper-

ating environment? ........................................................................90

The media becomes soiled when printed...........................................................91
Are the print heads dirty?.......................................................................91

Cutting is misaligned or skewed......................................................................92
Is the media loaded and set up correctly? ...................................................92
Are the settings for the cutting conditions appropriate? ..................................92
Is the length of output too long?...............................................................92
Are you using media that exhibits large expansion and contraction? ....................92

The printed surface is damaged when cutting .....................................................93
Does the tip of the blade holder cap scrap the printed surface? .........................93

Output Quality Problems 87



Do the print heads show nozzle clogging?

Carry out a printing test and make sure no nozzle clogging occurs. If nozzle clogging is present, perform
head cleaning.

 RELATED LINKS 

・  P. 31Printing Tests and Normal Cleaning

・  P. 73Medium/Powerful Cleaning

・  P. 75Manual Cleaning

Have you carried out[Calibrate Sheet Feeding] ?

Large misalignment in the amount of feed of the media may result in printing that seems coarse or con-
tains horizontal stripes. We recommend performing [Calibrate Sheet Feeding] before daily operations and
when changing the media type.

 RELATED LINKS 

・  P. 33Correcting the Media Feed

Have you carried out [Bidirectional adjustment] ?

We recommend performing [Bidirectional adjustment] before daily operations and when changing the me-
dia type. The optimal adjustment value may vary, depending mainly on the thickness of the media.

 RELATED LINKS 

・  P. 29Bidirectional Adjustment

Is the temperature of the room too low?

The heater may not warm up sufficiently when the ambient temperature is less than 20°C (68°F). Also,
even when the heater warms up, an adequate effect may not be obtained if the media is thoroughly chil-
led. Before printing, allow the media to come to room temperature.

Is the printer installed in a level and stable location?

Never install the machine in a location where it is tilted or where it may wobble or experience vibration.
Also make sure that the print heads are not exposed to moving air.

Is the printer installed in a location out of direct sunlight?

Never install in a location exposed to direct sunlight.

Is the media loaded and set up correctly?

If the media is not loaded and set up correctly, printing may be adversely affected. Make sure the media is
loaded and set up correctly.

Printed results are coarse or contain horizontal
stripes
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 RELATED LINKS 

・  P. 94Media Feed Problems

Printed results are coarse or contain horizontal stripes
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Did you shake the ink cartridges gently before installing them?

Shake new cartridges gently before you install them. So that the ink mixes well, periodically shake each
ink cartridge 50 times (about 20 seconds) horizontally with a stroke length of around 5 cm (1.97 in.) from
each end of the ink cartridge before reinserting it.

Is the media wrinkled?

If the media is wrinkled and comes loose from the platen, colors may be uneven or printing quality may
suffer.

 RELATED LINKS 

・  P. 94Media Feed Problems

Is the printer installed in a level and stable location?

Never install the machine in a location where it is tilted or where it may wobble or experience vibration.
Also, make sure that the print heads are not exposed to circulating air. These factors may lead to nozzle
clogging or reduced printing quality.

Is the printer being used in a location subject to severe changes in the operat-
ing environment?

Large fluctuations in temperature or humidity while printing is in progress may cause the colors to change
partway through. When you're performing printing, use the machine in a location where temperature and
humidity are stable.

Colors are unstable or uneven
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Are the print heads dirty?

The following may cause ink to drip on the media during printing.

• Buildup of fibrous dust (lint) around the heads.

• Ink transferred to the heads due to rubbing against the media.

If this happens, perform manual head cleaning. We recommend carrying out periodic print heads
cleaning.

• Too Low Humidity.

• Use this machine in the environment of 35 to 80 %RH (non condensation).

 RELATED LINKS 

・  P. 72Periodical Cleaning Maintenance

The media becomes soiled when printed
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Is the media loaded and set up correctly?

If the media is not loaded and set up correctly, or media feed is not smooth, cutting may be adversely
affected. Make sure the media is loaded and set up correctly.

 RELATED LINKS 

・  P. 94Media Feed Problems

Are the settings for the cutting conditions appropriate?

Misalignment or skewing may occur if the cutting speed is too fast or the blade force is too high. Try
changing the cutting conditions. With media having a strong adhesive layer, the adhesive layer reattaches
to itself immediately after cutting. However, if a cutting test shows that the peeling of the media and the
blade traces on the backing paper are optimal, then the media is being cut properly. Be careful not to
make the blade force too high.

 RELATED LINKS 

・  P. 40Adjusting Cutting

・  P. 42Accurately Adjusting the Cutting-in Amount

Is the length of output too long?

For printing & cutting in particular, the longer the page length (that is, the longer the distance the media
is returned after printing), the greater is the chance of misalignment occurring. It is a good idea to keep
the size of each single page to the minimum necessary.

Are you using media that exhibits large expansion and contraction?

When you're performing printing & cutting, misalignment occurs if the media expands or contracts. If this
happens, try performing printing with crop marks, then setting the base point and one or more align points
and performing cutting. This corrects for expansion and contraction of the media.

 RELATED LINKS 

・  P. 49Performing Printing and Cutting Separately

Cutting is misaligned or skewed
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Does the tip of the blade holder cap scrap the printed surface?

The tip of the blade holder cap may scrape, and soil or damage the printed surface. If this happens, in-
crease the amount of blade extension.

 RELATED LINKS 

・  P. 42Accurately Adjusting the Cutting-in Amount

The printed surface is damaged when cutting
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If an error message is displayed because the media has jammed, immediately correct the problem. Failure
to do so may damage the print heads.

 RELATED LINKS 

・  P. 114Error Messages

Is the media warped or wrinkled?

Many factors can cause warping or wrinkling. Refer to the following and correct the problem.

 RELATED LINKS 

・  P. 94Media Feed Problems

The Media Jams
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Is the media loaded and set up straight and securely?

Feed is not smooth when the media is not straight or is tensioned unevenly on the left and right. Reload
the media.

 RELATED LINKS 

・  P. 22Loading Media

Was loaded media allowed to stand for some time?

Media may shrink or wrinkle if it is heated for an extended time. When printing ends, press and hold down
the [POWER] key to switch off the sub power or remove the media.

Was the media loaded while the heater was hot?

Loading media after the heater has warmed up causes the temperature of the media to rise suddenly,
which may cause the media to shrink or wrinkle during printing. Before loading media, switch off the sub
power and allow the platen to cool.

Is the temperature of room too low?

Use this machine in an environment having an ambient temperature of 20 to 32°C (68 to 90°F). If the ma-
chine is used at an ambient temperature less than 20°C, then depending on the type or width of the me-
dia, wrinkling or temperature-caused unevenness may occur. To obtain stable printing results, the machine
should be used at an ambient temperature of 20 to 32°C (68 to 90°F).

Is the humidity of the room too high?

Use this machine in the environment of 35 to 80 %RH (non condensation).

Is the using media deflected?

If using the deflected media, it cause winkle of the media.

Media Wrinkles or Shrinks

96  Media Feed Problems



Is the media loaded and set up straight and securely?

Feed is not smooth when the media is not straight or is tensioned unevenly on the left and right. Reload
the media.

 RELATED LINKS 

・  P. 22Loading Media

Media Feed Is Not Straight
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Do the media strike some other object?

Make sure the media do not touch anything else. This may affect output, even when feed appears to be
smoothly.

 RELATED LINKS 

・  P. 22Loading Media

Is the media too thick?

Media that is too thick may not only cause unstable feed, but may scrape the print heads, resulting in mal-
function. Never use such media.

Are the grit rollers dirty?

Check to make sure the grit rollers are free of buildup of foreign material such as media scraps.

 RELATED LINKS 

・  P. 67Cleaning

Media Feed Is Not Smooth
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If the print-head carriage stops over the platen, take action immediately to prevent the heads from drying
out.

What to Do First

Hold down the [POWER] key for one second or longer to switch the sub power off, then back on. If the
media is jammed, then also remove the media.

If the print-head carriage move to the standby position (on the right side of the machine), it means the
operation has ended successfully.

If The Heads Still Do Not Move
Try switching off the main power, then again switching on the main power, followed by the sub power.

If the print-head carriage move to the standby

If the heads still do not move after "What to Do First" is performed, carry out the following emergency
response measure, then contact your authorized Roland DG Corp. dealer.

Procedure

1. Switch off the main power and open the front cover.

2. Gently move the print heads to the standby position.

Stopping at the place where the audible click is heard locks the print heads in place.

The Print Heads Stop Moving
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3. Gently apply pressure from the right side to make sure the print heads don't move to the left.

If the print heads move to the left, again move them slowly by applying pressure from the left side
and make sure they lock in place.

The Print Heads Stop Moving
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Is the power switched on?

Switch on the printer's main power, then press the [POWER] key and make sure the key lights up.

Does the [POWER] key stay steadily lighted?

Output is not performed when [POWER] key does not stay steadily lighted. After the media is loaded, pull
the loading lever.

Is the [POWER] key flashing?

When the [POWER] key flashes, no operation except for canceling output is accepted.

Is the cover open?

Close front cover, and maintenance cover.

Has ink run out?

If you send the output data in a state where there is no ink left, a warning buzzer will sound and the ma-
chine will stop temporality. A message indicating that ink has run out is displayed in the Status field of
Utilities. When the ink cartridge is replaced with a new one, printing or cutting starts.

 RELATED LINKS 

・  P. 64How to Replace the Ink Cartridge

・  P. 114Error Messages

Is a message displayed on the Utility icon in the task tray or in the Utility win-
dow?

 RELATED LINKS 

・  P. 112Messages

・  P. 114Error Messages

Is the cable connected?

Connect the cable securely.

 RELATED LINKS 

・ BN-20A Preparation Before Use

The Printer Unit Doesn't Run

102  Machine Problems

https://downloadcenter.rolanddg.com/BN-20A


Is the driver installed correctly?

If the connection to the computer is not made in the sequence described, the driver may fail to be instal-
led correctly. The Utility does not function normally when driver is misconfigured. Check again to ensure
that the connection was made using the correct procedure.

 RELATED LINKS 

・ BN-20A Preparation Before Use

Are two or more machines connected to a single computer?

The utility cannot control more than one machine at the same time. Never connect two or more instances
of this machine to a single computer.

Is the temperature of the room too low?

This machine does not complete startup until the heater reaches the specified temperature, and does not
accept any operation. When the ambient temperature is low, the heater is slow to warm up. Use the ma-
chine in an environment where the temperature is 20 to 32 °C (68 to 90 °F).

Did you forcibly remove any detachable external storage device connected by
USB?

When you remove the USB removable device (USB flash drive or USB hard disk etc.), you must run [Safely
Remove Hardware and Eject Media] or [Eject] before detaching it. If you remove the USB device without
it in process of printing, the printing may be aborted.

The Printer Unit Doesn't Run
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If installation quits partway through, or if the wizard does not appear when you make the connection with
a USB cable, take action as follows.

Windows 11

Procedure

1. Connect the machine and the computer with the USB cable, and switch on the machine.

2. If the [Found New Hardware] message appears, click [Cancel] to close it.

3. Right-click the Start menu, and then click [Device Manager].

When the [User Account Control] window appears, click [Continue]. The [Device Manager] win-
dow appears.

4. From the [View] menu, click [Show hidden devices].

5. Search the list for [Printers] or [Other devices], and then double-click it.

The name of your machine or [Unknown device] appears below the selected item. Click the name
to select it.

6. From the [Action] menu, click [Uninstall Device].

7. In the [Confirm Device Uninstall] window, click [OK].

8. Close the [Device Manager].

9. Disconnect the USB cable from the computer, and restart Windows.

10. Uninstall the driver according to the procedure below.

P. 107Uninstalling the Driver

11. Refer to "Preparation Before Use" to redo the installation from the beginning.

 RELATED LINKS 

・ BN-20A Preparation Before Use

Installation is impossible
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Windows 10

Procedure

1. Connect the machine and the computer with the USB cable, and switch on the machine.

2. If the [Found New Hardware] message appears, click [Cancel] to close it.

3. Right-click the Start menu, and then click [Device Manager].

When the [User Account Control] window appears, click [Continue]. The [Device Manager] win-
dow appears.

4. From the [View] menu, click [Show hidden devices].

5. Search the list for [Printers] or [Other devices], and then double-click it.

The name of your machine or [Unknown device] appears below the selected item. Click the name
to select it.

6. From the [Action] menu, click [Uninstall Device].

7. In the [Confirm Device Uninstall] window, click [OK].

8. Close the [Device Manager].

9. Disconnect the USB cable from the computer, and restart Windows.

10. Uninstall the driver according to the procedure below.

P. 107Uninstalling the Driver

11. Refer to "Advance Preparation" to redo the installation from the beginning.

 RELATED LINKS 

・ BN-20A Advance Preparation

Installation is impossible
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When uninstalling the driver, perform following operation.

If the driver is uninstalled without following the procedure given below, there is a possibility that it might not be able
to be re-installed.

IMPORTANT

Windows 11

Procedure

1. Switch off the machine, and disconnect the connector cable between the computer and the machine.

2. Log on to Windows as an administrator.

3. Right-click the Start menu, and then click [Apps and Features].

4. Select the driver of the machine you want to delete by clicking it, and then click [Uninstall].

5. A message prompting you to confirm deletion appears. Click [Yes].

Windows 10

Procedure

1. Switch off the machine, and disconnect the connector cable between the computer and the machine.

2. Log on to Windows as an administrator.

3. Right-click the Start menu, and then click [Apps and Features].

4. Select the driver of the machine you want to delete by clicking it, and then click [Uninstall].

5. A message prompting you to confirm deletion appears. Click [Yes].

Uninstalling the Driver
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These are cautionary notes on making output from Adobe Illustrator using the BN-20 driver.
These notes do not apply if you are using VersaWorks.

MEMO

When you want to perform cutting, clear the [Print As Bitmap] check box in the [Print] dialog box.

To display the [Print] dialog box, click [File]>[Print].

Set the document's color mode to [RGB].

If you select CMYK mode, the CMYK values will be converted to RGB values when the output is generated, so the color (RGB value)
specified as the cutting line may be changed. In this case, it may not be possible to perform cutting because the color specified for
the driver as the cutting line and the color output from Illustrator differ.

Do not cancel printing by operating Illustrator.

To cancel printing, hold down the [POWER] key on the BN-20A. When you print from Illustrator, the now printing dialog box is dis-
played. Even if you click the [Cancel] button in this dialog box, the printing process will continue running, and you will not be able
to operate Illustrator until this process finishes.

Important Notes When Performing Output from
Adobe Illustrator
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This is a cautionary note on making output from CorelDRAW using the BN-20 driver.
This note does not apply if you are using VersaWorks.

MEMO

Set the document's color mode to [RGB].

If you select CMYK mode, the CMYK values will be converted to RGB values when the output is generated, so the color (RGB value)
specified as the cutting line may be changed. In this case, it may not be possible to perform cutting because the color specified for
the driver as the cutting line and the color output from CorelDRAW differ.

Important Note When Performing Output from
CorelDRAW
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These are the main messages that appear in the Utility window to prompt correct operation. They do not
indicate any error. There are other messages that appear in the Utility window. Follow the displayed
prompts and take action accordingly.

[XX ink : Shake the cartridge well]

Remove the ink cartridge that is indicated in *** and shake it well.

 RELATED LINKS 

・  P. 67Maintenance of Ink Cartridges

[The Waste cartridge is full.]

The waste cartridge is full. Replace the waste cartridge with a new one.

 RELATED LINKS 

・  P. 69Replacing the Drain Cartridge

[Replace the wiper.]

It is time to replace the wipers. Replace the wipers.

 RELATED LINKS 

・  P. 79Replacing the Wiper

[Replace the felt wiper.]

It is time to replace the felt wiper. Replace the felt wiper.

 RELATED LINKS 

・  P. 81Replacing the Felt Wiper

[The connection to the printer has been released.]

A USB cable that connects this machine and the computer is unplugged, or the main power of this machine
is switched off. If the machine is allowed to stand with the main power switched off, the automatic main-
tenance fails to work and it may cause a machine malfunction. Make sure that the main power is on at all
times.

[Clean the printer manually.]

If [Clean the printer manually.] message is displayed on the screen of the computer connected to the
printer, be sure to perform manual cleaning.

 RELATED LINKS 

Messages
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・  P. 75Manual Cleaning

Messages
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This topic describes some of the error messages that may appear in the Utility window, and how to take
action to remedy the problem. In addition to the messages described below, the Utility window shows the
causes of errors and troubleshooting information. If the troubleshooting information displayed in the Utili-
ty window or action described here does not correct the problem, or if an error message not described
here appears, contact your authorized Roland DG Corp. dealer.

[The pinch roller position is incorrect.]

The media size is not acceptable for this machine, and thus the position of the pinch roller is not correct.
If the pinch roller position is incorrect, the media cannot be secured properly. Specific media sizes can be
positioned properly with the pinch roller on this machine.

 RELATED LINKS 

・  P. 16Usable Media

[Crop marks could not be printed. Output will be canceled.]

The size of the data including the crop marks is larger than the printing or cutting area of the loaded me-
dia.
Make the printing or cutting area wider, such as by replacing the media with a larger piece of media or by
changing the positions of the pinch rollers, then send the data again.

The size of the data being output is too small.
Set the size of the data in the new scanning value (direction in which the print heads move) to at least 65
mm (2.6 in.). Change the size of the data, then send the data again. There is no limitation in the size of
the data in the new feeding direction.

 RELATED LINKS 

・  P. 49Performing Printing and Cutting Separately

[Crop mark detection could not be started.] / [Crop marks were not found.
Output will be canceled.]

Automatic detection of crop marks could not be accomplished.
Load the media at the correct position and perform detection of crop marks again. If repeating automatic
crop-mark detection results in an error again, then change the type of media. Depending on the media, it
may not be possible to detect crop marks automatically.

 RELATED LINKS 

・  P. 49Performing Printing and Cutting Separately

・  P. 54Crop Cut Adjustment

[The operation has been stopped to prevent the print heads from drying out.
Turn the printer off.]

The print heads were forced to standby position to prevent them from drying out.
Operation cannot be continued. Switch the sub power off, then back on. Opening the front cover while
printing is in progress causes an emergency stop. Never allow the print heads to remain in this state.

Error Messages
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[Motor error]

A motor error occurred.
Operation cannot be continued. By following the messages displayed in the Utility window, remove the
media, close the front cover, and then hold down the [POWER] key to switch the sub power off. This error
may be caused by such factors as an incorrect loading of the media, a media jam, or an operation that
pulls the media with excessive force. Eliminate the cause of the error before switching the sub power on,
and then reload the media.

[Waste cartridge is estimated to be full]

Output is stopped because the waste cartridge is full.
Output cannot be resumed without correcting this error. Replace the waste cartridge with a new one by
following the message displayed in the Utility window. If a new waste cartridge is not available for imme-
diate replacement, switch the main power off.

[Temperature error]

The temperature of the location where the machine is installed has risen above or fallen below the ambi-
ent temperature at which the machine can operate.
Operation cannot be continued. Switch off the sub power. Bring the installed location to a temperature at
which operation is possible (20 to 32°C) and allow the machine to come to room temperature, then turn
on the power.

[Cover open error.]

Output is stopped because the front cover or the maintenance cover is open.
Start output again after closing the cover.

[Sheet setup error]

Setup of the media has failed. Load the media correctly.

 RELATED LINKS 

・  P. 22Loading Media

[Data error]

Output was stopped because a problem was found in the data received.
Operation cannot be continued. Check for errors in the data. Check for a problem with the connector ca-
ble or the computer, and start output again.

[Ink has run out.]

Output is stopped because ink has run out.
In the [Ink] tab of the Utility window, check the color of the cartridge that has run out of ink, and replace
the ink cartridge with a new one.

 RELATED LINKS 

・  P. 63Checking for Remaining Ink

Error Messages
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・  P. 64How to Replace the Ink Cartridge

[Pinch lever was returned.]

Output is stopped because the loading lever is pushed backward while output is in progress.
Pushing the loading lever backward cancels the setup of the media, so output is stopped. Reload the me-
dia.

[No sheet is present.]

Output is attempted but it fails because no media is present.
Set up the media.

[Printing cannot continue because the end of the sheet was detected. Printing
will be canceled.]

Printing is stopped because the trailing edge of the media is detected.
When the trailing edge of the media is detected, output is cancelled. Load new media.

[ServiceCall No**]

An unrecoverable error occurred, or part replacement that must be performed by a service technician is
required.
An unrecoverable error occurred, or part replacement that must be performed by a service technician is
required.

[Ink Cartridge error : *** ink cartridge ]

A cartridge that cannot be used was installed.
Remove the ink cartridge of the indicated color to clear the error. Use an ink cartridge of the specified
type. ("***" is the color of the ink)

[BN-20 Utility is already running.]

You try to start BN-20 utility though it is already running.
Utility is resident software that remains active even when it is hidden from the screen. When it is hidden
from the screen, it is located in the task tray in the lower right corner of the computer screen.

 RELATED LINKS 

・  P. 12Starting/Exiting Utility

[The cleaning liquid cartridge is empty. Replace the cleaning liquid cartridge
with a new one.]

Operation is stopped because the cleaning liquid cartridge is empty.
This message appears when operations such as "Head Wash" are in progress. Operation cannot be resumed
without correcting this error. Replace with a new cleaning liquid cartridge immediately. If the machine is
allowed to stand with the empty cartridge, it may result in a malfunction.

Error Messages
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To move the machine, you must completely drain all ink inside the machine and secure the print heads in
place with packing materials to protect them. Attempting to move the machine without first doing this
may result in damage to internal components due to leaking ink or damage to the print heads.

Required items

Unused cleaning cartridge (1) Dummy cartridges (3)

To purchase items that are sold separately, contact your authorized dealer.

Make sure to use a cleaning cartridge that corresponds to the ink type. Using the wrong cartridge may cause a machine
malfunction.

IMPORTANT

Preparing to Move the Machine
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Procedure

1. Open the Utility window.

P. 12Starting/Exiting Utility

2.

3. On the [Option] tab, click [Head Wash].

Proceed with the work by following the on-screen instructions. Do not switch off the power until
the work is completed.

4. Move the machine as soon as possible.

5. Immediately reinstall the machine and fill with ink.

Refer to "Advance Preparation" and promptly fill the machine with ink.

Important notes on moving

• Once the preparations for moving are complete, move the machine and fill it with ink with as little delay
as possible. Leaving the machine alone without ink may damage the print heads.

• When moving the machine, keep it at a temperature of 5˚C to 40˚C (41˚F to 104˚F) and at a humidity of
20%RH to 80%RH (with no condensation). Failure to do so may result in malfunction.

• Handle the machine with care when moving it, keeping it level (not tilted at an angle) and preventing it
from striking other objects.

IMPORTANT

Procedures from Preparing to Move to Reinstal-
lation
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Maximum Area

The printing or cutting area along the horizontal plane (the direction in which the carriages move) is de-
termined by the position of the pinch rollers.

Printing or cutting area

Left pinch roller

Right pinch roller

Printing or cutting coordinates origin (0,0)

A Max. 480 mm (18.89 in.)

B Max. 24,998 mm (984.2 in.)

C 5 mm (0.2 in.)

D 1.4 mm (0.06 in.)

Printing Area
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Maximum Area When Using Crop Marks

Printing or cutting area

Maximum area

Crop mark

A 12.5 mm (0.5 in.)

B 10 mm (0.4 in.)

Printing Area
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The cutting conditions and the service life of the blade change according to the media and the operating
environment, even when you're using identical blades. The service life also differs according to the type of
blade. A rough guide is shown below.

Blade Media Blade force Amount of blade offset
(amount of blade tip

correction)

Blade life (general
guide)*1

ZEC-U1005 General Signage Vinyl 50 to 150 gf 0.25 mm (0.01 in.) 8000 m (26,246.72 ft.)

ZEC-U5025 General Signage Vinyl
Fluorescent Vinyl
Fluorescent Vinyl

30 to 100 gf
120 to 200 gf
100 to 200 gf

0.25 mm (0.01 in.)
0.25 mm (0.01 in.)
0.25 mm (0.01 in.)

4000 m (13,123.36 ft.)
4000 m (13,123.36 ft.)
4000 m (13,123.36 ft.)

 

*1 The values for "Blade life" are estimates for when an identical type of material is used.
 

When uncut areas remain even when the blade force is increased to a value that is higher than the values shown in this
chart by 50 to 60 gf, replace the blade.

MEMO

About the Blade
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Unit: mm

Dimensional Drawings
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BN-20A

Printing technology Piezoelectric inkjet

Media Width*1 150 to 515 mm (5.9 to 20.3 in.)

Thickness Max. 1.0 mm (39.3 mil) with liner, for printing
Max. 0.4 mm (16 mil) with liner and 0.22 mm (9 mil) without liner, for cutting

Roll outer diameter Max. 150 mm (5.9 in.)

Roll weight Max. 6 kg (13.2 lb.)

Core diameter 76.2 mm (3 in.) or 50.8 mm (2 in.)

Printing/cutting width*2 Max. 480 mm (18.9 in.)

Ink cartridges Type 220-cc cartridge

Colors Four colors (cyan, magenta, yellow, and black)

Print resolution (dpi) Max. 1,440 dpi

Cutting blade Type Roland CAMM-1 series compatible

Blade offset 0.25 mm (9 mil)

Cutting speed 1 to 15 cm/s

Blade force 30 to 300 gf

Software resolution (when cutting) 0.025 mm/step

Distance accuracy (when printing)*4 Error of less than ±0.3% of distance traveled, or ±0.3 mm, whichever is great-
er

Repeatability (when cutting)*3*5 Error of less than ±0.4% of distance traveled, or ±0.3 mm, whichever is great-
er

Repeatability (when cutting)*3*6 ±0.1 mm or less

Alignment accuracy for printing and cutting*3*7 ±0.5 mm or less

Alignment accuracy for printing and cutting when
reloading media*3*8

Error of less than ±0.5% of distance traveled, or ±3 mm, whichever is greater

Print heater*9 Temperature: 35 °C (95 °F) (fixed)

Connectivity USB (compliant with Universal Serial Bus Specification Revision 2.0)

Power-saving function Automatic sleep feature

Power requirements AC 100 to 240 V ±10 %, 1.0 A, 50 / 60 Hz

Power consumption During operation Approx. 90 W

Sleep mode Approx. 5.5 W

Acoustic noise level During operation 62 dB (A) or less

During standby 42 dB (A) or less

Outer dimensions 1009 (W) x 582 (D) x 293 (H) mm (39.7 (W) x 22.9 (D) x 11.5 (H) in.)

Weight 36 kg (79.4 lb.)

Environment Power on*10 Temperature: 20 to 32 °C (68 to 90 °F)
Humidity: 35 to 80 %RH (non-condensing)

Not operating Temperature: 5 to 40 °C (41 to 104 °F)
Humidity: 20 to 80 %RH (non-condensing)

Included items Power cord, USB cable, blade, blade holder, User's Manual, etc.

 

*1 It must be within the ranges shown below:

• 150 to 170 mm (5.9 to 6.7 inch)
• 200 to 235 mm (7.9 to 9.3 inch)
• 287 to 322 mm (11.3 to 12.7 inch)
• 348 to 383 mm (13.7 to 15.1 inch)
• 393 to 429 mm (15.5 to 16.9 inch)

Specifications
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• 439 to 474 mm (17.3 to 18.7 inch)
• 487 to 515 mm (19.2 to 20.3 inch)

*2 The length of printing or cutting is subject to the limitations of the program.

*3 • Media type: Media specified by Roland DG Corp.
• Temperature: 25°C (77°F), Humidity: 50%
• Roll media must be loaded correctly.
• Front margin: 35 mm or more
• Excluding expansion/contraction of the media
• All correction or adjustment function of this machine has been made properly.

*4 With Roland PET film, print travel: 1 m

*5 Range for assured repetition accuracy: Length 1,000 mm

*6 Range for assured repetition accuracy: Length 1,000 mm

*7 • Provided that media length is under 1,000 mm
• Excludes the effects of slanted movement and of expansion and contraction of the media.

*8 • Data size: 1,000 mm in the media-feed direction, 480 mm in the carriage-movement direction
• No lamination
• Automatic detection of crop marks at 4 points when media is reloaded.
• Excluding possible shift caused by expansion/contraction of the media and/or by reloading the media.

*9 • Warm-up is required after power up. This may require 5 to 20 minutes, depending on the operating environment.
• Depending on the ambient temperature and media width, the temperature may fail to be reached 35 (°F).

*10 Operating environment
①： Use in an operating environment within this range.
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